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Installing

You install IBM® Operational Decision Manager through Installation Manager. You
can also install some components through a launchpad, which makes it easy to
perform a typical installation with everything you need to get started quickly with
the product. You can also use the silent installation mode to install Operational
Decision Manager on multiple workstations in a network.

Before you install, make sure that you have a valid license for the products that
you want to install.

Before you install

To improve your installation experience, ensure that you understand the
Operational Decision Manager installation concepts and requirements.

Operational Decision Manager licenses

IBM® Operational Decision Manager is composed of several components that
provide a variety of features. Depending on the type of license that you have, you
can install some or all of the components and their respective features. Ensure that
you install only the components for which you have a valid license.

The Operational Decision Manager licenses are either for development purposes or
for production purposes. Development licenses can be activated only as part of a
development and test environment for internal, nonproduction activities, whereas
production licenses are for using the product in production. During installation,
you specify how you intend to use the product.

If you have a Decision Server Advanced license and want to install Decision Server
Insights, see [[nstalling Decision Server Insights| for installation instructions and
[Features you can install| specific to this component.

Some components require that you install additional software. If you install by
using the launchpad, the required software is installed automatically.

The below table lists the product components that you are entitled to install
depending on the license that you have. It also specifies the components that you
can install by using the launchpad.

Table 1. License types and corresponding installable components

Installable by using the

License type Installable components launchpad
Decision Server Decision Server Rules Yes
Advanced Rules profile templates for Yes

WebSphere® Application Server

Decision Server Events No
Events profile templates for No
WebSphere Application Server

Business Rules Embedded No
Decision Server Insights No
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Table 1. License types and corresponding installable components (continued)

Installable by using the

Express

for WebSphere Application Server

Decision Center Express grants
you access to limited capabilities.
For example, you cannot use
Decision Center in a cluster
environment. Check the terms of
your license for more information.

License type Installable components launchpad
Decision Server Rules Yes

Decision Server -

Standard Business Rules Embedded No
Rules profile templates for Yes
WebSphere Application Server
Decision Server Rules Yes

Decision Server -

Express Business Rules Embedded No
Rules profile templates for Yes
WebSphere Application Server
Decision Server Express grants you
access to limited capabilities. For
example, you cannot use Decision
Server in a cluster environment.

Check the terms of your license for
more information.

Decision Center Decision Center Yes
Decision Center profile templates Yes
for WebSphere Application Server
Decision Center Yes

Decision Center — -

Decision Center profile templates Yes

Related information:

[[nstalling Decision Server Insights|

Software requirements

Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.

You can also use a launchpad to install the required software, including Installation
Manager. Otherwise, make sure that the required software is installed before you

begin the product installation.

The following table displays the software requirements that are supplied as part of

the installer.

For more information about the system and software requirements, see

Operational Decision Manager detailed system requirements|
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Table 2. Software requirements for Operational Decision Manager.

Software requirements

Description

Installation Manager 1.7.3

Installation Manager is required to install
the Operational Decision Manager product
packages. Installation Manager 1.7.3 comes
with licenses that include the launchpad.
The launchpad installs this version of
Installation Manager on your computer as
part of the installation procedure. If you
already have a version of Installation
Manager, ensure that you have the
minimum version requirement: Installation
Manager 1.7.1.

If you use Unix you can use the
console-based interface of Installation

Manager. For more information, see|Console

WebSphere Application Server Network
Deployment 8.5.5.3

If you intend to deploy a sample server or a
stand-alone server, you must install
WebSphere Application Server Network
Deployment V8.5.5.3. You use WebSphere
Application Server Network Deployment to
run the samples and tutorials, to install the
Event runtime, and to use the Event
widgets.

Note: To install WebSphere Application
Server Network Deployment on Linux and
AIX® systems, you must set the process
resource limits in the /etc/security/
Timits.conf file. If the value for the number
of open files is too low, errors can occur
when opening files or establishing
connections. To change the open file limit,
edit the /etc/security/limits.conf file, and
add the following values:

hard nofile 100000
soft nofile 100000

WebSphere eXtreme Scale 8.6.0

WebSphere eXtreme Scale is required only if
you intend to install the Event runtime.

WebSphere eXtreme Scale is used to install
the Event runtime. You must install
WebSphere eXtreme Scale in the directory of
WebSphere Application Server.

Eclipse 4.2.2.2

When you install by using Installation
Manager, you can choose to extend an
existing Eclipse environment. If you choose
to extend your Eclipse environment, ensure
that you have the required version: Eclipse
4222

Note:

You must update the standard version of
Eclipse 4.2.2.2. Go to the[Known Limitationg]
page to follow the steps that you must take
to update your Eclipse environment.
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Related tasks:

[‘Installing with the launchpad” on page 9|

Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

Related information:

Installing Decision Server Insights|

“Installing the product with Installation Manager” on page 12|

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

Downloading the product installers

The Operational Decision Manager installation repositories are provided as
downloadable compressed files through IBM Passport Advantage®, or on physical
DVDs.

Before you begin

You must copy or download the installation repositories onto your workstation. If
you download the repositories, you must extract them with an archiving utility of
your choice.

Procedure
1. Ensure that your installation repositories are copied to the same directory.
2. Choose the tar file that corresponds to your target operating system.

To avoid any issue with the repository extraction, make sure that the path to
the download directory is short. For example: C:\Download or /Download.

3. Extract the repositories:

* If you use WinZip, clear TAR file smart CR/LF conversion in Option >
Configuration > Miscellaneous.

* If you are an AIX user, you must use both the native UNIX tar command
and the GNU version of this command because the native utility does not
support long file names.

Results

As a result of the extraction and depending on your licenses, you obtain all or a
combination of folders named diskl, disk2, disk3, disk4 and disk5.

* diskl contains the installation repositories for WebSphere Application Server and
the IBM SDK Java" Technology Edition for WebSphere. It also contains the
launchpad executable files and the predefined response files for a silent
installation.

* disk2 contains the installation repositories for Decision Server Rules, the Rules
profile templates for WebSphere Application Server, and Rules embedded. It also
contains the launchpad executable files and the predefined response files for a
silent installation.

* disk3 contains the installation repositories for Decision Center and the Decision
Center profile templates for WebSphere Application Server. It also contains the
launchpad executable files and the predefined response files for a silent
installation.

IBM Operational Decision Manager: Installation Guide
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* disk4 contains the installation repositories for Decision Server Events and the
Events profile templates for WebSphere Application Server.

* disk5 contains the installation repositories for Decision Server Insights, and the
predefined response files for a silent installation.

Security

To help you configure applications safely, application servers check access to the
resources and manage access rights.

Operational Decision Manager is certified to support Federal Information
Processing Standards (FIPS) 140-2 and the National Institute of Standards and
Technology (NIST) Special Publications 800-131a security standard.

The FIPS 140-2 standard is an information technology security accreditation
program to certify cryptographic modules for use in government departments and
regulated industries that collect, store, transfer, share, and disseminate sensitive but
unclassified information.

To configure WebSphere Application Server V8.5.5 to run in NIST SP800-131A
mode (transition mode or strict mode), go to the following page: Efonﬁguringl
[WebSphere Application Server for SP800-131 standard strict modé.

Configuration of a secure mode on an application server provides ways to increase
the security of the application that you deploy.

In secure mode, an application server:

* Checks access to the resources: access to a class using the Java reflection
mechanism is not permitted without the appropriate security rights.

* Manages access rights: Rule Execution Server Console access is managed with
this mechanism.

By default, Rule Execution Server is installed with a minimum of security. The
Rule Execution Server Console application defines three specific roles:
resAdministrators, resDeployers, and resMonitors. The roles control access to the
various JSP/Servlets.

There is no specific permissions implementation for Rule Execution Server MBeans.
All that is required to access the MBeans using JMX are the correct credentials.

Java 2 Security provides a policy-based, fine-grain access control mechanism that
increases overall system integrity. Java 2 Security is independent of Java EE
role-based authorization. Java 2 Security can be disabled and enabled
independently of global security. However, on certain application servers when
global security is enabled, Java 2 Security is also enabled. Note that Java 2 security
can be disabled even though global security is enabled.

Note: Security configuration of Rule Execution Server might relate to your
application, domain, or server-scoped security policy in your enterprise. Review
security settings for applications that call Rule Execution Server with your Java EE
application architect or system administrator as appropriate.

You complete the installation of Decision Center and Rule Execution Server by

using an Installation Settings wizard. For Decision Center, the Installation Settings
wizard helps you create the correct groups in your application server when you set
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up security access. For Rule Execution Server, the Installation Settings wizard helps
you create the correct type of database schemas.

Communication protocols

Rule Execution Server support HTTP and the secured HTTPS communication
protocol. You can customize the protocol factory.

Communication with Rule Execution Server supports the HTTP or HTTPS
communication protocols. Communication with Rule Execution Server can occur
from Decision Center or Rule Designer.

You can customize the communication in two ways:
* To support nontrusted certificates in secure mode.
* To support custom protocols.

Secure mode

By default, HTTPS supports only trusted certificates. As a consequence, when you
communicate with Rule Execution Server in secure mode, you cannot connect
using a demo certificate that is not trusted by the default JVM. Your application
server raises an SSL handshake exception if you try to connect using a nontrusted
demo certificate. To enable communication to work with nontrusted certificates,
add the following Java system property in the start script of the application server:

-Dilog.rules.res.allowSelfSignedCertificate=true

To allow HTTPS on nontrusted self-signed certificates for Ant tasks, set the Java
system property ilog.rules.res.allowSelfSignedCertificate to true, as follows:

<property name="ilog.rules.res.allowSelfSignedCertificate" value="true"/>
Custom protocols

You can customize the protocol factory for a specific protocol by using the
following system properties:

* custom.protocol.factory: The fully qualified name of the protocol factory.

* custom.protocol.scheme: The protocol name for which the protocol factory is
customized.

* custom.protocol.defaultPort: The default port used for the protocol if no port is
specified in the URL.

You must launch the JVM that initiates the HTTP communication with these
system properties and your implementation of the protocol factory class
org.apache.commons.httpclient.protocol. ProtocolSocketFactory in the class path.

The protocol factory specified in custom.protocol.factory is instantiated and
registered if both the following conditions are satisfied:

e The HTTP client is instantiated.

* The protocol in the URL used for communication is the same as the value of the
property custom.protocol.scheme.

You can implement the protocol in one of the following ways:
* Execute an Ant task with the system properties:

IBM Operational Decision Manager: Installation Guide



-Dcustom.protocol.factory=com.ilog.MyProtocolFactory
-Dcustom.protocol.scheme=https -Dcustom.protocol.defaultPort=443

¢ Add the properties to the build.xml file:

<property name="custom.protocol.factory" value="com.ilog.MyProtocolFactory"/>
<property name="custom.protocol.scheme" value="https"/>
<property name="custom.protocol.defaultPort" value="443"/>

Third-party tools

When you install Operational Decision Manager, you also install some open source
third-party software tools.

Open source software
Operational Decision Manager includes a number of third-party open-source
libraries and tools to enhance your user experience with the product.

. "’EcliEse”l
. :”AEache Ant”l

IBM gratefully acknowledges the work of the Open Source community and the
many independent developers that build and support these Open Source packages.

The open source packages are provided to enhance Operational Decision Manager.
The packages are not supported by IBM and IBM does not endorse their suitability
for production use. For support, refer to the relevant user community through the

Home Page for each package.

Eclipse
Optionally, you can install Eclipse if you do not already have a version of this IDE
installed.

The standard Operational Decision Manager installer provides Eclipse as an
optional environment for the convenience of users. Eclipse is required for
successful application development with Operational Decision Manager, but users
can choose to install Operational Decision Manager onto an existing, version
compatible, Eclipse installation. You do not have to incorporate Eclipse into
applications that you develop using Operational Decision Manager. However,
certain features might require that specific Eclipse libraries be included in the final
application.

Apache Ant
Apache Ant is installed to provide a preconfigured build and deployment scripts.

Version 1.7.1 of Ant, the Java-based build tool, is provided in the
<InstallDir>/shared/tools/ant directory.

For more information about Ant, see |http://ant.apache.org]

Ant is installed as part of the Operational Decision Manager installation. It
provides a preconfigured build and deployment scripts. These scripts are integral
to development of applications that incorporate Operational Decision Manager and
can be useful as an element of the final application. However, they are not
mandatory elements of Operational Decision Manager applications. In Operational
Decision Manager powered applications, all product features are fully functional
even if Ant has not been incorporated into the final application.
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Installing Operational Decision Manager

Install Operational Decision Manager through one of the following installation
methods. Depending on your installation needs, you can install the product
through the launchpad or through Installation Manager. You can also perform a
silent installation to deploy Operational Decision Manager on multiple
workstations in a network.

Installing the product with the launchpad

Some of the Operational Decision Manager components come with a launchpad.
Use the launchpad to run a typical installation and get everything that you need to
get up and running with these components. Ensure that you install only the
components for which you have a valid license.

When you install through the launchpad, you install all of the component features,
the default environments, and the software requirements for the components that
you select. For example, the launchpad installs Installation Manager and the
appropriate profile templates for WebSphere Application Server, the default
application server for Operational Decision Manager.

After you install, the sample server does not require any configuration. The profile
is created the first time that you start the sample server.

Related tasks:

[“Installing with the launchpad” on page 9|

Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

[“Uninstalling Operational Decision Manager” on page 39
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Related information:

[“Installing the product with Installation Manager” on page 12

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

Starting the launchpad
Double-click one of the launchpad executable files, either Taunchpad.exe or
launchpad64.exe.

Before you begin

Save and extract the installation files on your workstation.

Review your user privileges carefully. If you decide to change the default
installation directory for Windows 7, ensure that you are aware of the user
privilege' limitations for directories under Program Files and Program Files
(x86). Your user privileges depend on your installation of Installation Manager,

and you must install the product with the same user privileges.

Important:

1. "User privileges" refer to the administrator and nonadministrator installation options.

8 1BM Operational Decision Manager: Installation Guide



On Windows 7, the Program Files and Program Files (x86) directories are
protected. As a consequence, if you do not install the product as an administrator,
you might encounter difficulties to run certain programs. To avoid this issue,
install the product in a directory other than Program Files and Program Files
(x86).

You must have a web browser to run the launchpad. The launchpad supports
Firefox and Internet Explorer.

About this task
Start the launchpad from any of the installation disks.

On Windows, if you want to install the product as an administrator, the user
privileges that are required for installing it depend on your version of Windows.

* On Windows 7: You must log in with an account that has administrator
privileges to install or update IBM Installation Manager and the other products.
Run the installer as Administrator by right-clicking the program file or shortcut
and selecting Run as Administrator.

If you want to install the Operational Decision Manager components with an
existing version of Installation Manager that you have on your workstation,
make sure that the User Account Control setting in the Control Panel is not set
at the lowest value. If this value is set to the minimum, the launchpad
automatically opens in administrator mode and installs a new version of
Installation Manager in addition to your existing version of Installation Manager.

* On other supported Windows versions: If you want to install as an
administrator, you must have a user ID that belongs to the Administrator group.

Procedure

To start the launchpad, double-click the launchpad executable file:

* On Windows, start Taunchpad.exe, or Taunchpad64.exe. The executable file
determines whether the launchpad is run in 32-bit or 64-bit mode. It does not
determine whether you install a 32-bit or a 64-bit Operational Decision Manager
installation.

To install the product as an administrator on Windows 7, right-click the
executable file and select Run as Administrator

* On Linux, start ./Taunchpad.sh.
What to do next

The launchpad guides you through the installation process. Select the components
and options that correspond to your installation needs.

Related information:

[“Installing with the launchpad’]

Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

Installing with the launchpad
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
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install your product components and all the available installation features. The
launchpad also installs the required software.

Before you begin

Review your license and install only the components for which you have a valid
license.

About this task

The launchpad guides you through the installation. When you start the launchpad,
you must first select from the components under Decision Server and Decision
Center.

Through the launchpad, you can also select your configuration options.
Procedure

To install IBM Operational Decision Manager through the launchpad:
1. Start the launchpad.

2. On the Welcome page, select your product licenses under Decision Server and
Decision Center. Click Next to continue your installation.

3. Select your installation options.

a. Are you installing for production purposes? After you install, is your
product used to serve users and clients? If so, select Yes. If not, select No.

b. The default application server is WebSphere Application Server. If you want
to install artifacts for other application servers, select JBoss, Tomcat, Oracle
WebLogic or WebSphere Liberty Profile.

c. If you want to install the tutorials and samples, select Yes.

Select Next.

4. Under Installation Information, specify a directory in which to install your
product.

a. In Windows 7, if you run the launchpad in user mode, the default
installation directory is C:\Users\IBM_ADMIN\IBM\0DM87

b. In Windows 7, if you run the launchpad as an administrator, the default
installation directory is C:\Program Files\IBM\ODM87

c. To specify a location other than the default location, click Browse. Note,
however, that on Windows 7, the Program Files and Program Files (x86)
directories are protected. Install the product in a directory other than
Program Files or Program Files (x86) to avoid any user privilege
difficulties.

5. Specify a user name and password. You use the user name and password to
sign in to Decision Center, the WebSphere Application Server administration
console, and use other applications. Enter a user name and password that do
not have spaces. The following is an example of an acceptable user name and
password:

e User Name: ODMadmin
e Password: ODMadmin

Important:

IBM Operational Decision Manager: Installation Guide



For security reasons, you must change your password and remove the
temporary response files that are created by the launchpad after the installation
is complete. These files are generated during the installation process in these
directories:

* On Windows:%TEMP%\IBM_LaunchPad_Typical_Install_<hash_key>
* On UNIX: /tmp/IBM_LaunchPad_Typical_Install<hash_key>
6. Click Next.

7. Review the license agreement and installation summary, and select the check
box to agree to the terms. If you do not select the check box, you cannot
continue with the installation.

8. Click Install Software. The installation begins.

During the installation, the installer prompts you to confirm that you want to
run the Installation Manager and other installation programs, click Yes to
accept.

The installation runs in the background. Do not close the launchpad even if the
progress bar shows 100% completion. Wait until the following message is
displayed: Installation completed successfully.

If you cancel the installation before its completion, the files and folders that are
already copied onto your computer are not deleted. You must uninstall the
products that the launchpad already installed with the Installation Manager,
and manually delete the remaining files before you run the launchpad again.
For more information, see |[“Uninstalling Operational Decision Manager” on|

9. Click Next to exit the launchpad.

Results

When the installation is complete, your product components are installed on your
workstation.

By default, they are installed in the following directories:

* Operational Decision Manager: <IBM_InstallDir>/0DM87/0DM, where
<IBM_InstallDir> refers to your IBM installation directory.

* WebSphere Application Server: <IBM_InstallDir>/0DM87 /WAS/AppServer, where
<IBM_InstallDir> refers to your IBM installation directory.

What to do next

Start the sample server with the Start menu shortcut. A profile is configured on
WebSphere Application Server Network Deployment to run the included samples
and tutorials.

Related concepts:

[“Post-installation configuration” on page 48|

After you install and check your installation, consult the configuration topics for
information about setting up your product. Depending on the installation option
that you select, you might have some configuration work to do.

[“Installing the product with the launchpad” on page §

Some of the Operational Decision Manager components come with a launchpad.
Use the launchpad to run a typical installation and get everything that you need to
get up and running with these components. Ensure that you install only the
components for which you have a valid license.
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[‘Software requirements” on page 2|
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.

Related information:

[“Installing the product with Installation Manager”|

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

Installing the product with Installation Manager

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

You must have an existing Installation Manager to install Operational Decision
Manager through Installation Manager. You must also ensure that you have the
required software.

When you install through Installation Manager, you select your Operational
Decision Manager components, features, and environments. Contrary to the
launchpad, you can select more finely the features that you want to install.

To install the Operational Decision Manager components, Installation Manager
must access the repositories for the components that you want to install. Edit the
preferences in Installation Manager to set the path to these repositories.

Related concepts:

[“Installing the product with the launchpad” on page §

Some of the Operational Decision Manager components come with a launchpad.
Use the launchpad to run a typical installation and get everything that you need to
get up and running with these components. Ensure that you install only the
components for which you have a valid license.

[“Software requirements” on page 2|
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.

[‘Upgrading from an Express license to a full license” on page 39|

You might want to upgrade from a Decision Center Express®” to a Decision Center
license or from a Decision Server Express to a Decision Server Standard or
Advanced license to benefit from the full range of capabilities that the product
offers.

Related tasks:

[“Installing with the launchpad” on page 9|

Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

[“Uninstalling Operational Decision Manager” on page 39
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Installation Manager overview
Install and maintain your IBM products with IBM Installation Manager.

Use the basic Installation Manager features:
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* Select a language pack within the installer.
* Update an existing product package.

* Modify an existing product package.

* Roll back a product package.

* Uninstall a product package.

When you use Installation Manager, select your user privileges carefully. You must
also be aware of a few concepts, such as package groups, the shared directory, and
the Eclipse languages.

User Privileges:

You can use IBM Installation Manager in administrative mode (root),
nonadministrative user mode (nonroot), or group mode. The mode determines the
directories and commands that you use for both Installation Manager and the
product package. You must be aware of this choice because the way you install
Installation Manager affects how you can install and configure the product.

You must log in with an account that has administrator privileges to install or
update Installation Manager and the other products. Run the installer as an
administrator by right-clicking the program file or shortcut and selecting Run as
Administrator.

The install.exe and userinst.exe commands install Installation Manager into
different directories. Changes that you make to the administrator installation of
Installation Manager do not affect the nonadministrator installation. Similarly,
changes that you make to the nonadministrator installation of Installation Manager
do not affect the administrator installation. Each instance of Installation Manager
must have its own installation directory and agent data location.

For more information on Installation Manager, see |Group road maps and the user|
finterface| and [Install as an administrator, nonadministrator, or group|in the
Installation Manager documentation.

Administrator mode

Use administrator mode when you have administrative privileges in Windows and
root privileges in Linux. You can administer and manage Installation Manager and
packages. You can install packages in a common location that is accessible by all
users on a system.

If you want the administrator user (root) to install products on a computer, run the
install executable file that is in the Installation Manager directory.

Nonadministrator mode

Use nonadministrator mode to install packages in a location that is accessible only
by the user who installs Installation Manager. In this mode, you cannot install
packages that require administrator access rights. The packages are installed with
nonadministrator rights. You can install only one instance of Installation Manager
for each user on a workstation.

If you want a specific user to install products on a computer, run the userinst
executable file that is in the Installation Manager directory.
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directory.”

Group mode

Use group mode to enable a group of users to share packages in a common
location and manage the packages with the same instance of Installation Manager.
Group mode is not supported on Windows.

If you want a group of users to install products on a computer, run the groupinst
executable file. If you install Installation Manager using the group mode, you can
install Installation Manager by using one account and offerings by using another
account that is in the same group.

For more information, see [Installation commands in the Installation Manager
documentation.

Package groups and the shared directory:

Installation Manager always installs the product in a package group, which is used
to group multiple packages into one manageable location.

Installation Manager specifies a default[“Package group”|and a[“Shared resources|

Package group

A package group is a directory where compatible packages share common
components such as a user interface or workbench.

You can create a package group or install the packages into an existing compatible
package group. Some packages cannot share a package group, in which case the
option to use an existing package group is disabled.

You might want to install the product in an existing package group if you installed
supported versions of compatible products such as IBM Integration Designer or
Rational® Application Developer, or Rational Software Architect, and you want to
extend it with Rule Designer, Event Designer and Insight Designer features.

When you install several packages at the same time, all the packages are installed
into the same package group. After you create the package group, you cannot
change the installation directory. The installation directory contains files and
resources that are specific to the product.

Shared resources directory

The shared resources directory is where Eclipse plug-ins and other files are located
so that they can be used by one or more product package groups. You can specify
the shared resources directory only the first time that you install a package. The
name of the shared resources directory depends on the first product that you have
installed.

You cannot change the directory location until you uninstall all packages.

Important: Installation Manager manages the contents of the shared resources
directory. You must not edit or modify any files in this directory.

Related tasks:
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“Installing Operational Decision Manager in a compatible IBM product” on page
18

You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

Languages:

During the installation, you can select the languages to install. English is selected
by default and it is always installed.

Language selection applies only to Eclipse features. A language pack is installed
for each language that you select so that you can start Eclipse in the locale for
these languages.

If you are extending an existing Eclipse, you must select the languages for which
you already have the language packs installed. If you select a language that is not
already installed in your existing Eclipse, you might get an error. To solve this
issue, clear the languages that are not installed in your Eclipse.

The Rule Designer user interface is installed with all the supported locales.
Therefore, even if you do not install a certain locale, for example French, the Rule
Designer views and editors in Eclipse are still shown in this language (French) if
you start Eclipse in this locale.

Setting up Installation Manager repositories
Before you install through Installation Manager, you must add the installation
repositories to the Installation Manager preferences.

Procedure
1. Start Installation Manager from the Windows Start menu or from a command
line.

2. Choose File > Preferences and specify the path to the installation repository
location.

For example, if you want to install Decision Server Rules, point to the
installation repository that contains this component: <installRepository>/
DecisionServerRules.

Installation Manager retrieves the product packages from the specified
repository locations.

For more information on how to set repository locations, see
preferences

What to do next

After you point to the installation directories, you can start the Installation
Manager installation and select your installation repositories.

Running Installation Manager

Start Installation Manager to install one or more Operational Decision Manager
components on your workstation. You must have an existing Installation Manager
and the required software to install through the Installation Manager.

Before you begin

Install Installation Manager 1.7.3 and the required software to install Operational
Decision Manager through Installation Manager.
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Specify the repository locations in the Installation Manager preferences.
About this task

When you install Operational Decision Manager through Installation Manager, you
select the product packages for which you have a valid license. Then, you can
select the features that you want to install.

Follow the Installation Manager panels to select the options that correspond to
your installation needs:

* Select your product packages

¢ Review the license agreements

* Select a package group and installation directory

* Select languages

* Select features

* Locate your instance of WebSphere Application Server

* Enter a user name and password

¢ Identify your installation needs: production or nonproduction
* Select your licenses

Procedure

Install Operational Decision Manager with Installation Manager:
1. From the Installation Manager welcome page, select Install.

2. Select the installation packages that correspond to your installation needs and
license entitlements. Then, click Next.

If your application server is WebSphere Application Server, ensure that you
select the profile templates that correspond to the Operational Decision
Manager component you are installing. For example, if you select Decision
Center, make sure that you also select the Decision Center profile templates
for WebSphere Application Server.

You can install one or all of the packages on the same workstation.

3. Review the license agreements for the selected packages. If you agree, select I
accept the terms of the license agreements, and then click Next. If you select
I do not accept the terms in the license agreements, you cannot continue
with the installation.

4. Select a package group:

a. Select Create a new package group to create a new package group for
Operational Decision Manager.

The default package group is 0DM87 and its name is IBM Operational
Decision Manager.

Important:

On Windows 7, you can change the default installation directory to a
location outside of Program Files and Program Files (x86) to avoid user
privilege conflicts.

The Program Files and Program Files (x86) directories are protected. You
must install Operational Decision Manager with the same user privileges
that you use to install Installation Manager to run your programs correctly.
For example, if you want to install under Program Files, you might have
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to install as an administrator. To avoid issues, install the product in a
directory outside the Program Files or Program Files (x86).
b. Click Next to continue.

5. Option: If you want to extend your packages to an existing version of Eclipse,
click Extend an existing Eclipse, and then click Browse to locate your
eclipse.exe file.

6. Select the languages to install for this package, and then click Next.

7. Select the product features that you want to install, and then click Next.

A set of features is already selected by default.

8. Select Application Server Location, and browse to your installation of
WebSphere Application Server where you want to deploy the applications,
and then click Next. For example <IBM_InstallDir>/WebSphere/AppServer.
By default, Operational Decision Manager supports JDK?. If you have an
existing WebSphere Application Server that runs JDK6, you must upgrade
your JDK version by using the installation option IBM WebSphere SDK Java
Technology Edition version 7.0.4.1.

9. Select Server Security, and enter a user ID and password for the sample
server profile on WebSphere Application Server, and then click Next. Your
user ID and password must not contain any white spaces. For example:

e User ID: odmadmin
e Password: odmadmin

You use the user ID and password to connect to the WebSphere Application
Server administrative console, the Event Widgets and the Events
Administration console.

10. Select the configuration that you require on the Licenses panel. If you intend
to use your installation to serve end-users and clients, select Yes. If not, select
No.

11. On the Summary page, review the selected features before you install the
packages, and then click Install.

12. Wait until the installation is complete, and then click Finish.

Results

The product is installed in the directory that you specify when you install. The
default installation directory is <IBM_InstallDir>/0DM87, where <IBM_InstallDir>

refers to your IBM installation directory.

The products and features that are installed depend on what you selected in
Installation Manager.

What to do next

To find out what your next steps are and how to get started with your installation,
see [“Post-installation configuration” on page 48]

Related concepts:

[“Troubleshooting the installation” on page 46|
If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.

Related information:
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[“Installing the product in an existing Eclipse environment” on page 19|
Installation Manager installs by default a new instance of Eclipse. However, if you
already have a supported version of Eclipse, you can choose to extend your
existing Eclipse.

[“Checking your installation” on page 32|

You can verify the content of the installation directory and use shortcuts to access
product components and information.

During the installation, you can select the languages to install. English is selected
by default and it is always installed.

[“Features you can install” on page 23|
In Installation Manager, you can select the features that you want to install within
each Operational Decision Manager component.

[Package groups and the shared directory]
Installation Manager always installs the product in a package group, which is used
to group multiple packages into one manageable location.

Installing Operational Decision Manager in a compatible IBM
product

You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

About this task

You can install Operational Decision Manager in the package groups of one of the
following products:

* IBM Eclipse SDK

* Rational Application Developer
* Rational Developer for z (RDz)
* Rational Software Architect

Before you start the installation, make sure that the repository locations of these
products are not selected in the preferences of Installation Manager.

Go to the following support page to check the supported versions:

« [IBM Operational Decision Manager detailed system requirements|

Procedure

1. When prompted to select a package group in Installation Manager, select Use
the existing package group.

Installation Manager displays the list of package groups available. The package
groups that are not compatible are disabled.

2. Select the destination package group.

The installation directory is automatically filled with the path to the selected
product.

3. Continue the installation.
Related concepts:

[“Package groups and the shared directory” on page 14|
Installation Manager always installs the product in a package group, which is used
to group multiple packages into one manageable location.
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Installing the product in an existing Eclipse environment
Installation Manager installs by default a new instance of Eclipse. However, if you
already have a supported version of Eclipse, you can choose to extend your
existing Eclipse.

Installing the required plug-ins and patch level:

Before you install the product in an existing Eclipse environment, make sure that it
contains the required plug-ins, and that the current patch level is installed.

Before you begin

Rule Designer requires Eclipse SDK 4.2.2. Be sure to install the appropriate patch
level. For more information about obtaining the right patch level, see OEerationai]

[Decision Manager V8.7 Known Limitationd Follow the procedure that is
documented on the known limitations page.

Procedure

Install and extract the correct patch.

Select Eclipse > Help > Install new software.

Enter a name in the Name field and click OK.

Clear the Group items by category. The six software features display.
Click Next twice.

Accept the terms of the license agreement.

No oo bk~owbd =

When the installation is complete, select Yes to restart.

Results

You can now extend your Operational Decision Manager components in Eclipse.
Extending an existing Eclipse environment:

If the required plug-ins are installed, you can extend your current Eclipse
environment.

Before you begin

The Eclipse instance to extend must contain an initialization (.1in1) file. If there is
no such file, you must create one in the same folder as your Eclipse .exe file. The
.ini file must have the same name as the Eclipse executable file. For example,
eclipse.exe and eclipse.ini.

About this task

The package files are installed in the package group directory that you select, but
the package functions are available in your Eclipse.

Procedure

1. In Installation Manager, when you are prompted to define your Eclipse, select
the check box Extend an existing Eclipse.

2. Browse to your compatible Eclipse IDE installation.
3. Continue the installation.
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Installing Rule Designer in an existing Eclipse:

After installing the product, and if you have not done so at installation time, you
can extend an existing Eclipse with Rule Designer. You can also change the JVM
that Rule Designer uses.

Extending Eclipse with the Rule Designer update sites:

You can use update sites to install Rule Designer on an existing Eclipse
environment after installing the product.

Before you begin

To install Rule Designer in an existing Eclipse installation, you must make sure
that you have the required plug-ins.

The ZIP files for the update sites are available if you have selected the
corresponding option in Installation Manager.

About this task

During the installation of Operational Decision Manager in Installation Manager,
you can extend an existing Eclipse. However, if you have not done so at
installation time, you can use the update sites provided in the distribution to
extend your Eclipse environment. The installation process is to add the Rule
Designer plug-ins from an installation of Operational Decision Manager into your
Eclipse.

Note:

If you install Rule Designer in an Eclipse environment that uses a non-English
locale:

* The Eclipse messages remain in that language.

* If Rule Designer provides the verbalizer for the language, you can create rule
artifacts in this language. If there is no verbalizer for this language, the rule
artifacts that you create are in English.

* Rule Designer messages appear in the non-English locale if it is supported,
otherwise they appear in English.

* To change the locale, so that everything is in English, add the osgi.n1=en_US
property to the <Eclipse_InstallDir>/configuration/config.ini file, and then
restart Rule Designer.

Procedure

1. In the configuration/config.ini file of your Eclipse installation, add the
IBM_DS_HOME property to define the variable to the Decision Server installation
directory.

The installation directory contains the components for Decision Server such as
executionserver and studio.

For example, IBM_DS_HOME=C:/Program Files/IBM/0ODM87 or C:/Program
Files/IBM/0DM87/0DM depending on your installation.

You can copy this property from the configuration/config.ini file provided
with the installation of Decision Server.

2. Start Eclipse or a supported IBM Eclipse-based product.
3. Switch to the Java perspective (click Window > Open Perspective > Java).
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4. Click Help > Install New Software.

5. Add the sites to install:
a. In the Install wizard, next to the Work with field, click Add.
b. In the Add Repository dialog, click Archive.

c. Browse to the <InstallDir>/studio/update-sites directory, click Open,
and select designer-base-update-site.zip.

InstallDir refers to your installation directory.
d. In the Name field, enter a name for the site, and then click OK.
This might take a few seconds.

e. Proceed the same way to add the rule-designer-update-site.zip update
site.

6. In the Work with field, select All Available Sites from the list.

7. Expand the Business rules and events category, and select IBM Decision
Server Designer Base and IBM Decision Server Rule Designer.

8. Click Next.
Eclipse calculates the dependencies and requirements.

9. In the Install dialog, click Next, select I accept the terms of the license
agreement, and click Finish.

The installation may take a few seconds to complete. If a security warning
about the validity of the software opens, click OK to proceed with the
installation.

10. Click Restart Now if you are prompted to restart Eclipse.
What to do next

You can also install the following update sites the same way. These update sites are
optional:

* IBM Decision Server Rule Designer Samples:
— rule-designer-samples-update-site.zip
* IBM Decision Server Scorecard Modeler:
— scorecard-update-site.zip
* IBM Decision Server COBOL management update sites:
— cobol-importer-license-update-site.zip
— cobol-importer-update-site.linux.zip (for installation on Linux)
— cobol-importer-update-site.win32.zip (for installation on Windows)
— cobol-update-site.zip

Tip:

You can check what you have installed by clicking Help > Install New Software,
and then clicking the What is already installed? link.

Changing the [VM used by Rule Designer:

You can change the JVM used by Rule Designer.
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About this task

On Windows, by default the Operational Decision Manager installer installs the
IBM Java Virtual Machine (JVM) with Rule Designer. However, you can select a
different JVM during or after installation. On UNIX, you must select a JVM during
installation.

You can change the JVM used by Rule Designer on an existing installation of
Operational Decision Manager. The Rule Designer shortcut runs Eclipse using the
JVM specified in the <EcTipse_InstallDir>\eclipse.ini file.

Note:

* You can also use the -vm and -vmargs in the command line of the eclipse.exe
file.

* To run on Sun Hotspot Virtual Machines, Rule Designer needs a PermGen size
of at least 128 MB. Use the --Tauncher.XXMaxPermSize parameter. For more
information, see [The Eclipse runtime options)

For more information on how to set the parameters in the eclipse.ini file, see

Eclipse.ini

Procedure
1. Change JVM in the <Eclipse_InstallDir>\eclipse.ini file.
2. Save the changes.

Installing Event Designer in an existing Eclipse:

After installing the product, and if you have not done so at installation time, you
can extend an existing Eclipse with Event Designer.

Extending Eclipse with the Event Designer update sites:

You can use an update site to install Event Designer on an existing Eclipse
environment after installing the product.

Before you begin

To install Event Designer in an existing Eclipse installation, you must make sure
that you have the required plug-ins.

The ZIP file for the update site is available if you have elected to install Event
Designer from the IBM Installation Manager options when installing the product.

About this task

During the installation of Operational Decision Manager in Installation Manager,
you can extend an existing Eclipse. However, if you have not done so at
installation time, you can use the update sites provided in the distribution to
extend your Eclipse environment. The installation process is to add the Event
Designer plug-in from an installation of Operational Decision Manager into your
Eclipse.

If you install Event Designer in an Eclipse environment that uses a non-English
locale:

* The Eclipse messages remain in that language.
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* Event Designer messages appear in the non-English locale if it is supported,
otherwise they appear in English.

* To change the locale, so that everything is in English, add the osgi.n1=en_US
property to the <Eclipse_Instal1Dir>/configuration/config.ini file, and then
restart Event Designer.

Procedure
1. Start Eclipse or a supported IBM Eclipse-based product.
2. Switch to the Java perspective (click Window > Open Perspective > Java).
3. Click Help > Install New Software.
4. Add the site to install:
a. In the Install wizard, next to the Work with field, click Add.
b. In the Add Repository dialog, click Archive.

c. Browse to the <InstallDir>/studio/update-sites directory, click Open, and
select event-designer-update-site.zip.

InstallDir refers to your installation directory, for example:
C:\IBM\0DM87\0DM

d. In the Name field, enter a name for the site, and then click OK.
There might be a pause for a few seconds after clicking OK.

5. In the Work with field, select the name of the site, which you provided in the
previous step, from the list.

6. Expand the Business rules and events category, and select IBM Decision
Server Event Designer.

7. Click Next.
Eclipse calculates the dependencies and requirements.

8. In the Install dialog, click Next, select I accept the terms of the license
agreement, and click Finish.

The installation may take a few seconds to complete. If a security warning
about the validity of the software opens, click OK to proceed with the
installation.

9. Click Restart Now if you are prompted to restart Eclipse.
What to do next

You can also install the following update sites the same way. These update sites are
optional:

Tip:

You can check what you have installed by clicking Help > Install New Software,
and then clicking the What is already installed? link.

Features you can install
In Installation Manager, you can select the features that you want to install within
each Operational Decision Manager component.

A default set of features is preselected but you can add or remove features
depending on your needs. For a detailed description of the installable components
and features, see the following sections:

« |“Decision Center features” on page 24|

* [“Decision Server features” on page 25

Installing 23



« |"Profile templates for WebSphere Application Server” on page 29

* |“Business Rules Embedded” on page 29|

Installation Manager automatically enforces any dependencies between features
and prevents you from clearing these dependencies.

After you finish installing the packages, you can add or remove features from your
product with the Modify Packages wizard in Installation Manager.

Decision Center features

The following table describes the features
Decision Center component.

Table 3. Decision Center features

available for selection in the IBM

Feature

Description

Decision Center

An environment for business users to
author, manage, and test their business and
event rules. It includes a repository for
storing business and event rules, and web
interfaces (Decision Center Business Console
and Decision Center Enterprise Console) for
business users to manage decisions.

By default, Decision Center is installed on
the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Decision Center on a
different WebSphere Application Server
profile, or install it on other supported
application servers. However, the Decision
Center Business Console is supported on
WebSphere Application Server V8.5.5 only.

Decision Center: Installation artifacts for
other application servers > Decision Center
for Tomcat

Provides the archives to deploy and
configure Decision Center on Tomcat. The
archives are copied to <InstallDir>/
teamserver/applicationservers/tomcat.

For more information, see |Configuring

Decision Center: Installation artifacts for
other application servers > Decision Center
for JBoss

Provides the archives to deploy and
configure Decision Center on JBoss. The
archives are copied to <InstallDir>/
teamserver/applicationservers/JBoss.

For more information, see [Configuring|

Decision Center: Installation artifacts for
other application servers > Decision Center
for WebLogic Server

Provides the archives to deploy and
configure Decision Center on WebLogic
Server. The archives are copied to
<InstallDir>/teamserver/
applicationservers/WebLogic.

For more information, see [Configuring
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Table 3. Decision Center features (continued)

Feature

Description

Decision Center: Installation artifacts for
other application servers > Decision Center
for Liberty profile

Provides the archives to deploy and
configure Rule Execution Server on Liberty
Profile. The archives are copied to
<InstallDir>/teamserver/
applicationservers/WLP855.

For more information, see [Configuring

Rule Solutions for Office (for Windows
only)

Rule Solutions for Office provides a way for
business users to create and edit business
rules in Microsoft Word or Excel.

This option copies the installer for Rule
Solutions for Office to your installation
directory. The executable file for the installer
is copied to <InstallDir>/Rule Solutions
for Office/RuleSolutionsForOffice.exe,
see [“Installing Rule Solutions for Office” on|
|}2age 22|

Samples and Tutorials

Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.

Local help system

The local help system option is selected by
default. Eclipse users who want to access the
local help through the F1 key must install
the product documentation locally.

For more information, see |Installing and|

laccessing the documentation locally]

Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a
32-bit compatibility library installed.

Decision Server features

The following table shows the features in

the IBM Decision Server package.

Table 4. Components shared between Decision Server Rulesand Decision Server Events.

Shared components

Description

Samples and Tutorials

Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.
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Table 4. Components shared between Decision Server Rulesand Decision Server

Events. (continued)

Shared components

Description

Update sites for installation into other
Eclipse products

Provides compressed files that contain the
Eclipse update sites (and a copy of the
Designer plug-ins) to install Rule Designer
and Event Designer features into an existing
Eclipse. This feature provides an alternative
way of installing the Designer plug-ins into
a supported Eclipse after the installation of
Operational Decision Manager.

For more information, see |[Extending Eclipse|
[with the Rule Desiener update sites

Local help system

The local help system option is selected by
default. Eclipse users who want to access the
local help through the F1 key must install
the product documentation locally.

For more information, see |Installing andl

laccessing the documentation locally]
Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a

32-bit compatibility library installed.

Table 5. Decision Server Rules

Decision Server Rules Features

Description

Rule Designer

Rule Designer is a development environment
within Eclipse to design business rule
applications. It is aimed at developers,
business analysts, and architects. The Rule
Designer views and editors are available from
the Rule perspective in Eclipse.

Rule Designer > Scorecard Modeler

Scorecard Modeler is a set of extra plug-ins
that are integrated into Rule Designer. You
can use Scorecard Modeler to create
scorecards, integrate them into your business
rules, and share them across multiple
platforms.

Important: Scorecard Modeler is not installed
by default using the launchpad. Use
Installation Manager instead, to select the
feature and install it.
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Table 5. Decision Server Rules (continued)

Decision Server Rules Features

Description

Rule Execution Server

Rule Execution Server is an execution
platform for business rules that embeds the
rule engine. It also provides a console to
manage and monitor the execution of
business rules.

By default, Rule Execution Server is installed
on the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Rule Execution Server
on a different WebSphere Application Server
profile, or install it on other supported
application servers.

Select your intended use in accordance with
your license type:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only as
part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for Tomcat

Provides the archives to deploy and configure
Rule Execution Server on Tomcat. The
archives are copied to <InstallDir>/
executionserver/applicationservers/tomcat.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see |Configuring Rule

|Execution Servegl

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for JBoss

Provides the archives to deploy and configure
Rule Execution Server on JBoss. The archives
are copied to <InstallDir>/executionserver/
applicationservers/JBoss.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see |Configuring Ruld

|Execution Servegl
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Table 5. Decision Server Rules (continued)

Decision Server Rules Features

Description

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for WebLogic Server

Provides the archives to deploy and configure
Rule Execution Server on WebLogic Server.
The archives are copied to
<InstallDir>/executionserver/
applicationservers/ WeblLogic.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see|Configuring Rulq

|Execution Servej

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for Liberty profile

Provides the archives to deploy and configure
Rule Execution Server on Liberty Profile. The
archives are copied to <InstallDir>/

executionserver/applicationservers/WLP855.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see |Configuring Rule

|Execution Serveﬂ

Table 6. Decision Server Events

Decision Server Events features

| Description

WebSphere Application Server is a prerequisite for Decision Server Events.

Event Designer

A development environment within Eclipse
to design, develop, test, deploy, and monitor
event applications. Event Designer is
available from the Event perspective in
Eclipse.

Runtime > Event Runtime

The event runtime is an execution platform
that manages real-time business event
coordination. The event runtime requires
WebSphere eXtreme Scale and must be
deployed and configured on WebSphere
Application Server.

Select your intended use in accordance with
your license type:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only
as part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Runtime > Event Tester Enabler

If Event Tester Enabler is selected, then the
Event Tester widget is available.
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Table 6. Decision Server Events (continued)

Decision Server Events features Description

Runtime > Event Connectors (Legacy) Event connectors provide data connections
between the event runtime and external
systems. Legacy connectors include email
and ftp.

Event Widgets for Decision Server The Event Tester widget provides a way to
test the event logic in a business process.
This widget is aimed at testing and must be
used only on a test installation. Do not use it
on a production installation as it might
affect performance.

Integration Components You can install integration components into
the tooling of WebSphere ESB and
WebSphere Message Broker to allow these
products to send and receive data from
Decision Server Events.

Profile templates for WebSphere Application Server

When you install one of the Decision Server Events, Decision Server Rules, or
Decision Center features, you must also install the corresponding profile templates.
There are three profile templates:

* Rules profile templates for WebSphere Application Server
* Events profile templates for WebSphere Application Server
* Decision Center profile templates for WebSphere Application Server

These components contain the events and rules template profiles and runtime that
are required to deploy Operational Decision Manager on a WebSphere Application
Server.

For details on profile templates, see [Operational Decision Manager profile]

Business Rules Embedded

With Business Rules Embedded, you can use business rules to dynamically
configure the behavior of an Eclipse Rich Client Platform (RCP) application or a
Dojo-based web application.

For detailed information about this component, see [Business Rules Embedded|

Related information:

[[nstalling Decision Server Insights|

Installing Rule Solutions for Office
Once the installation of Decision Center is complete, you can manually run the
installer for Rule Solutions for Office.

Before you begin

If you installed the product with Installation Manager, make sure that you selected
the Rule Solutions for Office feature, see [“Features you can install” on page 23
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You must have a supported version of Microsoft Office to install Rule Solutions for
Office. For details, see [Working with Microsoft Office]

About this task

Rule Solutions for Office is an optional component that provides a way for
business users to create and edit business rules in Microsoft Word or Excel. The
Rule Solutions for Office feature in Installation Manager copies the installer for
Rule Solutions for Office to your installation directory.

Procedure
1. Navigate to <InstallDir>/Rule Solutions for Office/
2. Double-click the RuleSolutionsForOffice.exe file to run it.

3. Follow the steps in the installation wizard.

Installing on multiple workstations

You use the silent installation mode to install the product features on multiple
workstations in an automated way. You perform a silent installation using the
command line.

You perform a silent installation of the product by running Installation Manager
with response files that correspond to the features that you want to install. You can
create response files by recording them with Installation Manager. You can also use
the template response files that are provided with the product, and adapt them to
your needs.

Installing Installation Manager silently
You install Installation Manager in silent mode to automate its installation on
several workstations.

About this task

If you have the Operational Decision Manager launchpad, which is available with
Decision Center and Decision Server Rules, you can use the installc.exe or
userinstc.exe executable files supplied with the product to install Installation
Manager silently.

Procedure

1. Go to the installation directories that you have copied on your local disk and
locate the IM or IM64 directory.

2. At a command line, run one of the following command:

You can add these commands to a script file in order to automate the
procedure.

* If you are an administrator, enter:
(Windows) installc.exe -silent -acceptlicense
(Linux) ./installc -silent -acceptLicense

* If you are not an administrator, enter:
(Windows) userinstc.exe -silent -acceptlLicense
(Linux) ./userinstc -silent -acceptlicense

Recording a response file with Installation Manager
You perform a silent installation using response files. Use Installation Manager to
create the necessary files.
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Procedure
1. Create a temporary directory to store the result of the recording.
2. Open a command line and go to <im_install_dir>\eclipse.

3. Open a command line and enter the following line to start Installation
Manager:

You can give the response file a name of your choice.
* (Linux)

./IBMIM -record /path/to/response.xml -skipInstall /path/to/<tempDir>
* (Windows)

IBMIM.exe -record \path\to\response.xml -skipInstall \path\to\<tempDir>

The -skipInstall parameter avoids installing the components on your
computer.

4. Click File > Preferences, and enter the path to the Installation Manager
repository that corresponds to the component that you want to install.

5. Select the features you want to install.
6. Click Install and close Installation Manager.

What to do next

You can use the response file to perform a silent installation. You can dispose of
the files that are generated in <tempDir> as part of the procedure.

Editing template response files
A number of template response files are provided so that you can adapt them to
your installation requirements.

About this task

If you have the launchpad, you can find the template response files in the
responsefiles repositories on the installation disks.

If you are installing Decision Server Insights, you must install the component on
your computer to obtain the template response files. After the installation is
complete, go to the directory <InstallDir>/doc/silent to find the template
response files.

Procedure
1. Locate the template response file you want to adapt.

2. Open it in a text editor and replace the placeholders delimited with the!
character with the actual value.
For example, if you are installing WebSphere Application Server, replace
IWAS_REPOSITORY! with the path where the server is located. The list of the
required values and of the product component features are given in the
response file. Replace the features placeholder with the feature that you would
like to install.

Running a silent installation
You can perform a silent installation of the product using response files that you
record or the template response files.
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About this task

If you have the launchpad, which is available with Decision Center and Decision
Server Rules, you can find the template response files in the responsefiles
repositories on the installation disks.

If you are installing Decision Server Insights, you must install the component on
your computer to obtain the template response files. After the installation is
complete, go to the directory <InstallDir>/doc/silent to find the template
response files.

Procedure
1. Open a command line and go to the directory where you installed Installation
Manager.

2. Go to the directory eclipse\tools.

3. To install the product components with response files, type the following
command:

On Windows, as an administrator:

imcl.exe -accessRights admin -input \path\to\<response file> -nosplash -silent -acceptLicense
On Windows, as a user:

imc1.exe -accessRights nonAdmin -input \path\to\<response file> -nosplash -silent -acceptlicense
On Linux, as an administrator:

./imc1 -accessRights admin -input /path/to/<response file> -nosplash -silent -acceptLicense

On Linux, as a user:

./imc1 -accessRights nonAdmin -input /path/to/<response file> -nosplash -silent -acceptlicense

What to do next

You can add these commands to a script file to automate further the procedure.

Checking your installation

32

You can verify the content of the installation directory and use shortcuts to access
product components and information.

Folders in the installation directory

After you finish installing the Operational Decision Manager components, you can
verify the content of the installation directory.

In your file system, go to your <Instal1Dir> folder: for example, C:\Program
Files\IBM\ODM87. The Operational Decision Manager components are installed in
the following folders:

Table 7. Component-folder mapping

Component | Folders

Decision Server Rules

Rule Designer studio

Rule Execution Server executionserver
Getting started tutorials gettingstarted
Shared third-party tools shared

Sample server shared/samplesServer
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Table 7. Component-folder mapping (continued)

Component Folders

.NET engine and migration tool dotnet

Configuration files and plug-ins for Rule configuration

Designer

Local help system and XML schemas doc

Extensions to Rule Designer dropins

Files to package plug-ins into a feature features

during Eclipse configuration processing

Eclipse plug-ins plugins

JDK (Windows only) Jdk

License agreement files Ticense

Provisioning system files p2

Decision Server Events

Legacy event connectors connectors

Files that support the event runtime engine. |runtime

This directory also includes the compressed

files for downloading and installing the

Event Tester, and the Event Capture and

Event Replay widgets.

Events connectors ca

Configuration files config

Configuration files and plug-ins for Event configuration

Designer

Extensions to Event Designer dropins

Integration with other IBM products such as |integration

WebSphere Message Broker and WebSphere

ESB

Decision Center teamserver, Rule Solutions for Office
(optional)

Business Rules Embedded rules-sdk

IBM Installation Manager installs the Eclipse plug-ins in the shared resources
directory. The shared resources directory contains resources that can be shared by
one or more package groups. This directory is managed by IBM Installation
Manager and you must not modify anything in this directory.

The Eclipse plug-ins are also copied to <InstallDir>/studio/update-sites
providing that you selected the corresponding option in IBM Installation Manager
when installing the product. The update sites are delivered as ZIP files that you

can extract to view the plug-ins.

If you install the component Profile templates for WebSphere Application Server,
the corresponding folders are located in the following directories:

<WAS_InstallDir>/profileTemplates/rules for rules profiles.

<WAS_InstallDir>/profileTemplates/wbe for events profiles.
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Menu shortcuts

For each component that you install in Windows, the installer adds shortcuts to the
menu. You can access the shortcuts through the start menu.

Your choice of installation determines what shortcuts the installer adds to the
shortcut menu. If, for example, you choose Rule Designer, the shortcut for Rule
Designer is added. If you choose Rule Execution Server, the shortcut for the Rule
Execution Server console is added.

Assuming you have installed every single Operational Decision Manager
component, you get the following menu shortcuts.

Start menu navigation Shortcuts
Start > All Programs > IBM > The following is available under the package group
Package_Group level:

* Event Designer opens Eclipse in the Event
perspective.

* IBM Knowledge Center opens the product
documentation online.

* Rule Designer opens Eclipse in the Rule
perspective.

* Getting Started Tutorials
* Help and Support
* Sample Server

* Rule Solutions for Office opens rule solutions for
Office. This shortcut is only available if you install
Rule Solutions for Office. To install Rule Solutions
for Office, you must select the corresponding
option in Installation Manager. You then run the
installation manually by using the provided .exe
file in <InstallDir>/Rule solutions for Office.

Start > All Programs > IBM > The following is available under Getting Started
Package_Group > Getting Started | tutorials:

Tutorials * Decision Center Business console opens the
Getting Started for the Business console.

* Decision Center Enterprise console opens the
Getting Started for the Enterprise console.

* Decision Server Events opens the Getting Started
for Events.

* Decision Server Rules opens the Getting Started
for Business Rules.

Start > All Programs > IBM > You can use this shortcut to find the following
Package_Group > Help and documentation and support information:
Support + Collect Data for Problem Analysis opens the IBM

Support Assistant Data Collector for collecting
diagnostic data.

* Online Support opens the IBM Support home
page.

* Start Information Center (local) starts the local
version of the product documentation.

* Stop Information Center (local)
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Start menu navigation Shortcuts

Start > All Programs > IBM > You can use this shortcut to access the following
Package_Group > Sample Server sample server tools and functions.

* Administrative console opens the WebSphere
Application Server administrative console.

* Decision Center Business console opens the
Decision Center Business console and targets a
database that contains the provided sample
projects in the en_US persistence locale.

* Decision Center Enterprise console opens the
Decision Center Enterprise console, and targets a
database that contains the provided sample
projects in the en_US persistence locale.

* Events Administration console opens the
Administration user interface for Events.

* Rule Execution Server Console opens the Rule
Execution Server console.

* Samples console (en_US) opens Eclipse in the
Samples console perspective with the en_US locale
(American English).

* Start server starts the sample profile on
WebSphere Application Server.

* Stop server stops the sample profile on
WebSphere Application Server.

* Events tools:

— Connectors opens the tooling for Events legacy
connectors.

— Event Widgets opens the web application in a
web browser.

— Properties opens the Properties tool.

Shortcut commands
A list of the components that you can access via shortcut commands.

The installer adds relevant shortcuts in batch (.bat) files on Windows and Bash
shell script (.sh) files on Linux.

You can consult the shortcut commands for your respective operating system
environment:

. ”Windows”l

* [“Linux” on page 36|

Windows

Shortcuts Windows commands

Administrative console (Sample <InstallDir>/shared/bin/

Server) Administrativeconsole.bat

Connectors <InstallDir>/connectors/bin/connectors.bat

Decision Center Enterprise console |<InstallDir>/shared/bin/dcecopener.bat
(Sample Server)

Decision Center Business console |<InstallDir>/shared/bin/dchcopener.bat
(Sample Server)
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Shortcuts

Windows commands

Events Administration console

<InstallDir>/shared/bin/EventRuntimeopener.bat

Event Designer

<InstallDir>/eclipse.exe -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/
GettingStartedServerRules.bat

Getting Started for Decision Center
Business console

<InstallDir>/images/
GettingStartedCenterBusinessConsole.bat

Getting Started for Decision Center
Enterprise console

<InstallDir>/images/
GettingStartedCenterEnterpriseConsole.bat

Getting Started for Decision Server
Events

<InstallDir>/images/
GettingStartedServerEvents.bat

Information center (remote)

<InstallDir>/images/InfoCenterOnline.bat

Collect Data for Problem Analysis

<InstallDir>/shared/isadc/index.html

Properties

<InstallDir>/connectors/bin/propertiesui.bat

Rule Execution Server console
(Sample Server)

<InstallDir>/shared/bin/dsopener.bat

Rule Designer

<Eclipse_InstallDir>/eclipse.exe -init
-consolelog -perspective
ilog.rules.studio.ui.perspectives.RuleEditingPerg

Samples console (en_US)

<Eclipse_InstallDir>/eclipse.exe -init
-consolelog -nl en_US -perspective

ilog.rules.studio.samples.console.perspectives.SgmplesPerspective

Start server (Sample Server)

<InstallDir>/shared/bin/startserver.bat

Stop server (Sample Server)

<InstallDir>/shared/bin/stopserver.bat

Linux

Shortcuts

Linux commands

Administrative console (Sample
Server)

<InstallDir>/shared/bin/Administrativeconsole.sh

Connectors

<InstallDir>/connectors/bin/connectors.sh

Decision Center Enterprise console
(Sample Server)

<InstallDir>/shared/bin/dcecopener.sh

Decision Center Business console
(Sample Server)

<InstallDir>/shared/bin/dcbcopener.sh

Events Administration console

<InstallDir>/shared/bin/EventRuntimeopener.sh

Event Designer

<InstallDir>/eclipse -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/GettingStartedServerRules.sh

Getting Started for Decision Center
Business console

<InstallDir>/images/
GettingStartedCenterBusinessConsole.sh

Getting Started for Decision Center
Enterprise console

<InstallDir>/images/
GettingStartedCenterEnterpriseConsole.sh

Getting Started for Decision Server
Events

<InstallDir>/images/
GettingStartedServerEvents.sh

Information center (remote)

<InstallDir>/images/InfoCenterOnline.sh
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Shortcuts Linux commands

Collect Data for Problem Analysis |<InstallDir>/shared/isadc/start_isadc.sh

Properties <InstallDir>/connectors/bin/propertiesui.sh

Rule Execution Server console <InstallDir>/shared/bin/dsopener.sh

(Sample Server)

Rule Designer <Eclipse_InstallDir>/eclipse -init -consolelog
-perspective

ilog.rules.studio.ui.perspectives.RuleEditingPergpective

Samples console (en_US) <Eclipse_InstallDir>/eclipse -init -consolelog
-n1 en_US -perspective
ilog.rules.studio.samples.console.perspectives.SgmplesPerspect:

Start server (Sample Server) <InstallDir>/shared/bin/startserver.sh

Stop server (Sample Server) <InstallDir>/shared/bin/stopserver.sh

Starting Rule and Event Designer

Open Rule Designer or Event designer from the start menu shortcut, or from the
Eclipse that contains Rule Designer or Event Designer. You can update the
configuration file to open them in a specific locale.

Opening Rule and Event Designer
You can open Rule Designer or Event Designer from the start menu shortcut, or by
starting the Eclipse that contains them.

About this task

You can open Rule Designer or Event Designer from the start menu shortcut, or by
starting the Eclipse that contains them.

By default, the Rule and Event designer open in the locale of your operating
system. If you want to change the locale, see [‘Opening Rule and Event Designer in|
la specific locale” on page 38|

Procedure

To open the Rule Designer for example, do one of the following actions:
* Click Start > All Programs > IBM > package_group > Rule Designer .

package_group refers to the package group specified in IBM Installation Manager
during installation. The default package group is Operational Decision Manager
V8.7.

e Start the Eclipse in which you have installed Rule Designer, and switch to the
Rule perspective.

Results

On IBM AIX and SUN Solaris, Rule Designer and Event Designer run in headless
Eclipse. This means that you can only start them from the command line.

If you have used a previous version of Rule Designer or Event Designer, perform a

full clean and then rebuild your existing projects in the Eclipse workspace the first
time you start V8.7.
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The Eclipse Welcome page (Help > Welcome) provides an entry point to the
overview, tutorials, and samples.

Related information:

[‘Opening Rule and Event Designer in a specific locale”|

You can start Rule Designer or Event Designer in a locale other than the locale of
your operating system. If you are using a bidirectional locale, you can also change
the display orientation of Eclipse.

Opening Rule and Event Designer in a specific locale

You can start Rule Designer or Event Designer in a locale other than the locale of
your operating system. If you are using a bidirectional locale, you can also change
the display orientation of Eclipse.

About this task

By default, the Designers open in the locale of your operating system. You can
change the locale by adding a property to the config.ini file.

Note:

Rule Designer and Event Designer open in the specified locale if you have selected
the locale in IBM Installation Manager, when installing Decision Server.

Procedure

To change the locale of Rule Designer for example:
1. Open <InstallDir>/configuration/config.ini.

<InstallDir> refers to the installation directory of Operational Decision Manager.
However, if you installed Operational Decision Manager in an existing Eclipse,
the config.ini file is located in the configuration folder of your Eclipse
installation directory.

2. Add the following properties:
* osgi.nl=<locale>: to specify the locale, for example osgi.n1=fr_FR.

* (Optional) eclipse.orientation=<orientation>: to change the display
orientation of Eclipse, for example eclipse.orientation=1tr.
1tr defines a left-to-right orientation, and rt1 defines a right-to-left
orientation.

For bidirectional locales such as Arabic and Hebrew, the rule editors are
localized and displayed from right to left. However, the rest of the Rule
Designer interface is not localized. If you start Eclipse in a bidirectional
locale, it is displayed from right to left, but Rule Designer remains in
English. You can use the 1tr value to display Rule Designer from left to
right, and the editors from right to left.

3. Save the changes.

Note:

* You can also use the -n1 <locale> argument in the command line to start
Eclipse. For example, -n1 fr_FR.

* You can also use the -dir <orientation> argument in the command line to
start Eclipse with a specific orientation. For example, -dir 1tr.

Related information:

[“Opening Rule and Event Designer” on page 37|
You can open Rule Designer or Event Designer from the start menu shortcut, or by
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starting the Eclipse that contains them.

[Defining a calendar format]

Upgrading from an Express license to a full license

You might want to upgrade from a Decision Center Express to a Decision Center
license or from a Decision Server Express to a Decision Server Standard or
Advanced license to benefit from the full range of capabilities that the product
offers.

To upgrade to a fully-fledged version of the product, you cannot simply use the
Modify option of the Installation Manager. You must first uninstall the Express
version completely from your computer, and then reinstall it by using the
launchpad or Installation Manager.

Related tasks:
[“Uninstalling Operational Decision Manager”|

Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Related information:

[“Installing the product with Installation Manager” on page 12|

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

Uninstalling Operational Decision Manager

Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Before you begin

Before you uninstall, stop all processes that might access existing Operational
Decision Manager databases. In particular, if you use Derby databases, stop the
Derby Java process, and ensure that your current database directory does not have
a residual Derby lock file. The presence of the Derby lock file causes the
installation to fail. To remove the Derby lock file, go to <InstallDir>/shared/data/
derby/resdb and remove the db.1ck file.

Stop all the applications that run with the product, including the server, the local
help, and any instance of Rule Designer or Event Designer.

Manually delete the 0DMSamp1e8700 profile for WebSphere Application Server
before you uninstall. The 0DMSamp1e8700 profile is created when you start the
Sample server. For more information, see [Deleting profiles|

If your packages have any dependencies, you must uninstall the packages and
their respective dependencies.

You must have the same user privileges to uninstall Operational Decision Manager
as you use to install the product on your workstation. Log in to your workstation

with the same user account that you use to install the product packages.

Uninstall Operational Decision Manager with the correct instance of Installation
Manager:

Installing 39


http://www.ibm.com/support/knowledgecenter/SSQP76_8.7.0/com.ibm.odm.distrib/../com.ibm.odm.dserver.rules.designer.author/authoring_topics/tsk_calendar_format_define.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.nd.multiplatform.doc%2Fae%2Ftpro_removeprofile.html

* If you installed the product as an administrator, you must use the administrator
instance of Installation Manager to uninstall it. You can access the administrator
instance through the IBM Installation Manager start menu shortcut. Right click
IBM Installation Manager, and then select Run as administrator.

* If you installed the product as a nonadministrator user, you must use the
nonadministrator instance of Installation Manager to uninstall it. You can access
the nonadministrator instance through the IBM Installation Manager start menu
shortcut.

About this task

Remove components and features through the Modify option in Installation
Manager. Remove the entire Operational Decision Manager product through the
Uninstall option in Installation Manager.

Procedure
1. Close the programs that you installed with Installation Manager.
2. Start Installation Manager from the Start menu.

3. Depending what you want to uninstall, click Modify or Uninstall. Select
Modify to uninstall components and features. Select Uninstall to uninstall the
entire Operational Decision Manager product.

4. Select the components that you want to uninstall, then click Next and
Uninstall.

Related concepts:

[“Upgrading from an Express license to a full license” on page 39

You might want to upgrade from a Decision Center Express to a Decision Center
license or from a Decision Server Express to a Decision Server Standard or
Advanced license to benefit from the full range of capabilities that the product
offers.

[“Installing the product with the launchpad” on page §

Some of the Operational Decision Manager components come with a launchpad.
Use the launchpad to run a typical installation and get everything that you need to
get up and running with these components. Ensure that you install only the
components for which you have a valid license.

Related information:

[“Installing the product with Installation Manager” on page 12

Use Installation Manager to install Operational Decision Manager. When you
install through Installation Manager, ensure that you install only the components
for which you have a valid license.

What's next?

Review the following topics after you install Operational Decision Manager.

Enabling IBM License Metric Tool (ILMT)

IBM License Metric Tool (ILMT) helps you manage license allocation services on
supported systems. In general, it recognizes and monitors the products that are
installed and in use on your system.

IBM License Metric Tool is enabled for Operational Decision Manager for
inventory support only. It is able to detect product installation and deployment of
Operational Decision Manager, but not its usage.
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When installed and activated, the tool scans your system for product inventory
signatures that indicate whether a product is installed on your system. It also
identifies the version, release, and modification levels of the product.

Decision Center:

IBM License Metric Tool reports the Decision Center when the application is
deployed to an application server.

The application must be deployed as an exploded archive for the tool to detect it.

* On WebSphere Application Server and Tomcat, an archive is exploded by default
during deployment.

* On other application servers, an archive must be exploded before deployment:

— [Deploying on WebLogic Server|

~ [Deploying on JBoss|

- [Deploying WebSphere Application Server Liberty profilel

Decision Server:

IBM License Metric Tool reports every deployment of the execution server namely,
Insight Server, Rule Execution Server, Event runtime, Classic rule engine, and
Decision engine.

IBM License Metric Tool also reports usage of Rule Execution Server when the
eXecution Unit resource adapter is deployed as an exploded archive.

* On WebSphere Application Server and Tomcat, an archive is exploded by default
during deployment.

* On other application servers, an archive must be exploded before deployment:

— [Deploying on WebLogic Server|

— [Deploying on JBoss|

- |Deploying WebSphere Application Server Liberty profile]

Important: For Java SE application that embeds the rules engine or the J2SE Rule
Execution Server, you must deploy the file with the suffix .swidtag found in
<InstallDir>/1icense/ilmt.zip along with Operational Decision Manager JAR
files.

Installing and accessing the documentation locally

You can access the product documentation over the internet. However, you can
install a local version of the documentation if you want to work offline or do not
have an internet access. If you are an Eclipse user, you must install the
documentation locally to be able to consult it from within the IDE.

Downloading the product documentation on your computer
To consult the product documentation locally, you must download the
documentation files on your computer.

Before you begin
The Local help system option is checked by default in the Installation Manager. To
consult the documentation locally, you must first start the local help and then

download the documentation files. Note that the download of the files requires
you to have access to the internet. This access will no longer be required later.
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About this task
Important:

The local help system does not work on 64-bits platforms such as Red Hat
Enterprise Linux (RHEL) that do not have a 32-bits compatibility library installed.

Procedure
1. Start the help system in one of the following ways:

* In the Start menu, click All Programs > IBM > package_group > Help and
Support > Start Information Center (local).

package_group refers to the package group specified in IBM Installation
Manager during installation.

* Run the following script:
— <InstallDir>/doc/help_start.bat on Windows
— <InstallDir>/doc/help_start.sh on Linux.
To run the information center in a locale other than English, add the locale
argument (-n1 xx_XX) to the <InstallDir>/doc/help_start.bat or

<InstallDir>/doc/help_start.sh file, before the -vmargs argument. For
example:

-eclipsehome eclipse -n1 fr_FR -configuration configuration_iehs

A new browser window opens. The documentation does not display because
you still must download the documentation content.

Important:

If you installed the product on Windows 7 in the Program Files or Program
Files (x86) directory without administrator privileges, you might not be
able to start the help system. To avoid potential issues, be sure to install the
product with administrator rights or in a different directory.

2. Click £ Update in the toolbar to display a list of the documentation sets that
are already installed.

3. Click Next to display a list of documentation sets that you can install. The list
includes documentation sets in English and other supported languages.

4. Click Install. The Update wizard installs the documentation.
5. Click OK, then click Finish.

6. Refresh the page to view the documentation.
Results

The documentation is installed on your computer.

Accessing the local contextual help in Eclipse environments
To access the product documentation and the contextual help from within Rule
Designer, Event Designer or Insight Designer you must download the
documentation files locally.

Before you begin
By default, the local help system is installed on your machine unless you uncheck
the corresponding option in Installation Manager. You must then download the

files onto your local disk through an Internet connection.
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About this task

To use the local contextual help from the Designers, you must start the local
instance of the information center. The installer inserts the necessary parameters to
access the help from the Designers.

If you want to change the parameters to point to a different instance of the
information center, for example a shared information center server running on an
internal network, you can modify the values in the Designers.

Procedure
1. Check that the settings to use the local help are set correctly:
a. Click Window > Preferences > Help > Content.
b. Make sure Include remote help and give it priority is selected.
c. Select the link to the information center and click Edit.
d. Make sure that the local information center has the following values:
¢ Name: Local
* URL: http://localhost:3333/help

Make sure the local help entry is at the top of the list. If not, move it up by
using the Up button.

e. Click OK, and then click Apply and OK.
2. Start the local help:
* In the Start menu, click All Programs > IBM > package_group > Help and
Support > Start Information Center (local)

* Run the <InstallDir>/doc/help_start.bat (Windows) or
<InstallDir>/doc/help_start.sh (Linux)

Important:

If you installed the product on Windows 7 in the Program Files or Program
Files (x86) directory without administrator privileges, you might not be able
to start the help system. To avoid potential issues, be sure to install the product
with administrator rights or in a different directory.

3. On the Help menu, click Help Contents.

If you have already installed the documentation, the local information center
for the Operational Decision Manager product family, Decision Center, and
Decision Server is displayed.

Running a shared information center on an internal network
You can run the information center on an internal network.

Before you begin
Before running the information center on an internal network, make sure that you

have installed the documentation locally as described in [‘Downloading the|
lproduct documentation on your computer” on page 41

About this task

If you have selected the Local help system option, you can set the help system up
so that the information center runs on an internal network.
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Procedure

To start the information center on an internal network:

1. Run <InstallDir>/doc/IC_start.bat on Windows or <InstallDir>/doc/
IC start.sh on Linux.

By default, the shared information center runs on port 9999.

2. Optional: To modify the default port, edit the IC_start.bat or IC_start.sh file,
and modify the port argument. For example, -port <port_number>.

When the shared information center is started, it is accessed using browsers
from other systems at the address http://<hostname>:<port>/help.

Note: To access different locales in the information center, specify the locale at
the end of the URL. For example, http://<ic_hostname>:9999/help/
index.jsp?lang=xx_XX

The locales include de_DE, es_ES, fr_FR, it_IT, ja_JP, ko_KR, pl_PL, pt_BR,
ru_RU, zh_CN, and zh_TW.

3. Optional: Configure the help preferences in Rule Designer to access the
information center:

a. Click Window > Preferences > Help > Content.
b. Select Include remote help and give it priority, then click New.

c. Enter the values for the information center that you want to connect to, for
example:

* Name: Operational Decision Manager information center
* Host: <ic_hostname>
e URL: http://localhost:9999/help

d. Click OK, and then click Apply and OK.

The contextual help now uses your new parameters.

Stopping the local help
Before uninstalling the product offerings in Installation Manager, you must stop
the information center process to avoid encountering uninstallation issues.

To stop the local information center:
* On Windows, run <Instal1Dir>/doc/help_end.bat.
* On Linux, run <Instal1Dir>/doc/help_end.sh.

To stop the shared information center:
* On Windows, run <Instal1Dir>/doc/IC_end.bat.
* On Linux, run <Instal1Dir>/doc/IC_end.sh.

Redirecting contextual help in web consoles

By default, the contextual help in web consoles points to the online documentation.
To redirect the contextual help to point to a local or network instance of the
documentation, you must change the value of the URL in the EAR file where it is
defined.
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About this task

To redirect the contextual help to a local instance of the documentation, you must
first change its URL in the EAR file to the local URL, and then redeploy the EAR

file.

Procedure
1. Update the EAR file. This file is located in these directories:

Decision Center Business console:<instal1Dir>/teamserver/
applicationservers/WebSphere85/jrules-teamserver-WAS85.ear

The value to modify is defined in the preferences.properties file in the
decisioncenter.war file.

Decision Center Enterprise console:<instal1Dir>/teamserver/
applicationservers/WebSphere85/jrules-teamserver-WAS85.ear

The value to modify is defined in the preferences.properties file in the
teamserver.war file.

Rule Execution Server console:<installDir>/executionserver/
applicationservers/WebSphere85/jrules-res-management-WAS85.ear

The value to modify is defined in the web.xml file in the
jrules-res-management.war file.

2. Once done, recreate the archive and redeploy it as explained below.

a.

i.
j-

Start the sample server. From the Start menu, choose IBM > Operational
Decision Manager V8.7 > Sample server > Start server.

To start the sample server, you can also go to <InstallDir>/shared/bin, and
then start startserver.bat or startserver.sh, depending on your operating
system.

Start the Administrative console. From the Start menu, choose IBM >
Operational Decision Manager V8.7 > Sample server > Administrative
console.

To start the sample Administrative console, you can also go to
<InstallDir>/shared/bin, and then start AdministrativeConsole.bat or
AdministrativeConsole.sh, depending on your operating system.

Sign in with the credentials that you provided when you installed the
product.

Select Applications > Application Types > WebSphere enterprise
applications. The Enterprise Applications table displays.

Select the application that interests you.
Click Update.
The Application update options display.

. Under Specify the path to the replacement ear file, browse to and select

your updated EAR file.

. Click Next, and continue to click Next until you get an option to finish, and

then click Finish.

The Save option appears at the bottom of the screen.
Click Save.

Sign out of the Administrative console.

Starting the sample server

Before you develop, test, and run the samples and tutorials, you must start the
Sample Server. You can start the sample server from the Start menu.
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About this task

No additional configuration is required start the sample server.

When you start the sample server for the first time, the ODMSample profile is
configured on WebSphere Application Server Network Deployment to run the
included samples and tutorials.

Start the sample server from the Start menu shortcut.
Procedure

From the Start menu, click All Programs > IBM > package_group > Sample Server
> Start server. package_group refers to the package group specified in IBM
Installation Manager when you install the product. The default package group is
Operational Decision Manager V8.7. The profile creation takes several minutes to
complete. Wait until the build completes successfully.

What to do next

You can perform a number of introductory tasks using the environment that is
installed for you by the sample server installer:

* Perform the Getting started tutorials, and other component-specific tutorials, see
-Tutorial

* Run the samples from the samples console in Eclipse, see [Product samples|

For more information, see [Using the sample server|

Note:

 If you are using the sample server profile to run Events, you can use the same
username and password to log in to the Event Widgets and to the Events
Administration console.

* Single sign-on (SSO) authentication is activated for the sample server. With 5SSO,
users can log in once and gain access to all applications without being prompted
to log in again for each of them. If you use different sign-on credentials for the
applications on the sample server, for example when performing certain samples
and tutorials, you get an error message when you attempt to sign in to the
second application.

To avoid this issue, you must sign out of the first console and then sign in to the
second console. Alternatively, you can sign in to all of the applications on the
server by using the credentials that you entered at installation time.

Troubleshooting the installation

If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.

When you contact IBM support, make sure that you have the following
information at hand:

* Version of Installation Manager installed

* Components installed and version numbers
* Operating system

* Installation Manager logs

Installation logs

IBM Operational Decision Manager: Installation Guide


http://www.ibm.com/support/knowledgecenter/SSQP76_8.7.0/com.ibm.odm.distrib/../com.ibm.odm.distrib.overview/topics/con_sitemap_tutorials.html
http://www.ibm.com/support/knowledgecenter/SSQP76_8.7.0/com.ibm.odm.distrib/../com.ibm.odm.distrib.samples/topics/con_sitemap_samples.html
http://www.ibm.com/support/knowledgecenter/SSQP76_8.7.0/com.ibm.odm.distrib/../com.ibm.odm.distrib.samples/smp_console_topics/tpc_smpserver_using.html

If you have difficulties installing the product through Installation Manager,
retrieve the installation logs to find out more information on the issues
encountered.

* Installation Manager:

— Windows 2000, XP, and 2003: C:\Documents and Settings\Al1l
Users\Application Data\IBM\Installation Manager\logs

— Windows Vista, 7, and 2008: C:\ProgramData\IBM\Installation
Manager\logs

— UNIX: /var/ibm/InstallationManager/logs

For more information, see [Finding IBM Installation Manager|
[troubleshooting logs|

* Launchpad:
— Windows: $TEMP%\IBM_LaunchPad_Typical_Install_<hash_key>\
%TEMP% is the environment variable that defines the location of your
Temp directory. <InstallType> refers to the type of installation that you

selected. If the launchpad fails before even starting the installation, no
installation type is indicated in the folder name.

— UNIX: /tmp/IBM LaunchPad Typical Install<hash_key>/
Limitations and known issues

To find a list of the current limitations and known issues, check the
technote [Known limitations in Operational Decision Manager V 8.7}

Setting up your environment to automate processes

To deploy RuleApps to Rule Execution Server, automate managerial tasks within
Decision Center, and run many of the samples, you must have Ant installed on
your computer.

About this task

The required version of Ant is 1.7.1 (or later). If Ant is not installed, or your
version is older than version 1.7.1, you must set up your environment to use the
correct version of Ant.

You can download Ant from |http://ant.apache.org/| or you can use the Ant 1.7.1
distribution packaged in the following directory: <InstallDir>/shared/tools/ant.

Procedure

To test and set up your environment to use Ant:
1. Set the ANT_HOME environment variable to <Instal1Dir>/shared/tools/ant.

2. Set the JAVA_HOME environment variable to the path to your JDK installation
(version 1.7.1).

3. Add the directory <InstallDir>/shared/tools/ant/bin to your PATH
environment variable.

4. Test your current version of Ant by typing the following in a Windows
command prompt or UNIX shell:

ant -version
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Post-installation configuration

After you install and check your installation, consult the configuration topics for
information about setting up your product. Depending on the installation option
that you select, you might have some configuration work to do.

Your post-installation configuration depends on the components that you install
and your use of the product. You might, for example, use an application server
other than WebSphere Application Server. You might, for example, want to use
your product installation for production purposes. Both examples require
configuration after you install.

Configuring your application server

The default application server is WebSphere Application Server. If you select the
artifacts for another application server when you install, you must configure your
product. Consult the appropriate configuration topics. For more information, see
the configuration topics.

« |Configuring Operational Decision Manager on Tomcat]

+ |Configuring Operational Decision Manager on JBoss51| and [Configuring]
Operational Decision Manager on JBoss61]

+ |Configuring Operational Decision Manager on Oracle WebLogic Server]

Configuring your application on a production server

After you install Rule Designer and Event Designer, some configuration is required
before you can start to design your application in Decision Server:

+ To execute your rule-based application, see [Configuring Rule Execution Server|

* To execute iour application with event processing, see [Configuring Decision|

Server Events

* To deploy the Operational Decision Manager runtime profile templates for
WebSphere Application Server, see [Operational Decision Manager profile|
* For business users to edit and test rules in Decision Center, see .

For more information, see [’Configuring your application on a production server.”|

To get a better understanding of the development lifecycle with Operational
Decision Manager, see [Business rule application development|

Related tasks:

Configuring Decision Server Events on WebSphere Application Server|

“Installing with the launchpad” on page 9|

Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

Related information:

Configuring Rule Execution Server on WebSphere Application Server|

Configuring the Decision Center consoles on WebSphere Application Server|
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England SO21 2JN

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England SO21 2JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
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imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at ’
trademark information|’ at www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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